S

Intro to Arduino

Zero to Prototyping
In a Flash!

Material designed by Linz Craig, Nick Poole, Prashanta Aryal,
Theo Simpson, Tai Johnson, and Eli Santistevan



Overview of Class

Getting Started.:

Installation, Applications and Materials

Electrical:

Components, Ohm's Law, Input and Output, Analog and Digital
Programming:

Split into groups depending on experience

Serial Communication Basics:

Troubleshooting and Debugging

Virtual Prototyping:

Schematics and PCB Layout in Fritzing
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Arduino Board

“Strong Friend” Created in Ivrea, Italy

in 2005 by Massimo Banzi & David Cuartielles ﬂ
Open Source Hardware open source

AMEL Processor

Coding is accessible & transferrable - (C++, Processing, java)

This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 United States License.



http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/

Arduino...

IS the go-to gear for artists, hobbyists,

students, and anyone with a gadgetry
dream. N —

rose out of another fi
how to teach stude
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Getting Started

« SW Installation: Arduino (v.1.0+)
Fritzing
SIK Guide Code
Drivers (FTDI)

« Materials: SIK Guide

Analog I/O, Digital 1/O, Serial,
& Fritzing handouts

Arduino CheatSheet
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PWR IN USB
(to Computer)
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(12C Bus)
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5V /3.3V/GND

L Digital NO
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: . PWM(3, 5, 6, 9, 10, 11)
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Analog
INPUTS
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PWR IN USB
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(12C Bus)
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L /7 ‘Bad L Digital NO
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Go ahead and plug your board in!

r!\t_\

= I0REF
-REéET

=33V = o
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=6 2
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-2
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Arduino Shields

PCB Built Shield Inserted Shield
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Arduino Shields

LCD

Micro SD MP3 Trigger

0.0
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0%
0°0%0%%

This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 United States License.



http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/

Name

SIK Components

Image Type Function

Notes

Push Button

Trim
potentiometer
Photoresistor

Relay

Temp Sensor
Flex Sensor
Soft Trimpot

RGB LED

Digital Input Switch - Closes
@ or opens circuit
Analog Input Variable resistor

~ Analog Input Light Dependent
1 Resistor (LDR)

Digital Output  Switch driven by
a small signal

’ Analog Input Temp Dependent

Resistor
ooy Analog Input Variable resistor
o Analog Input Variable resistor

T“=‘p -

- Dig & Analog 16,777,216
Output different colors

Polarized, needs
resistor

Also called a
Trimpot.
Resistance varies
with light.

Used to control
larger voltages

Careful of shorts

Ooh... So pretty.
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SIK Components

Jumper Wire ——— LED (5mm) l—+
Various Colors (Light Emitting Diode) B
x30 x10 x1
33022 Resistor 10K<Q2 Resistor
& &

* ACTUAL SIZE * AGTUAL SIZE

Potentiometer Diode
(1N4148)
* AGTUAL SIZE
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SIK Components

Photo Resistor

x1

. E

Piezo Element

Temp. Sensor
(TMP36)

Transistor
(P2N2222AG)

Push Button

E-.oj
[ u
@ @
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Flex Sensor

x1

SparkFun RedBoard

Soft Potentiometer

x1

X4 =

= I0REF

= RESET

=aav

o 5¥ i T
= GND -

= GND =
= VI 3 JALTRTT)

A A & A A& AA
R LI TT I RNT

x1

]

x1
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Relay

Integrated Circuit
(IC)

LCD

Breadboard

Standard Solderless (Color may vary)
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Electricity \ Electronics Basic Concept
Review

Ohms Law

Voltage

Current

Resistance

Using a Multi-meter
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Ohm’s Law

Ohm's Law describes the direct relationship between
the Voltage (V), Current (I), and Resistance (R) of a
circuit.

The three different forms of Ohm's Law are as follows:

V V
V=I'RI=- R=-
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V=IR
Electrical Properties

Voltage Current Resistance
\Y I R

« Defined as * The rate of « Opposition
the amount charge flow to charge
of potential INn a circuit. flow.
energy in a  Units: Amperes « Units: Ohms (Q)
circuit. (A)

 Units: Volts (V)
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Voltage Analogy
— )
Water — -,
Tower
Water
Tower

0

o,
bbb

More Energy == Higher Voltage

VI

®®
o

Less Energy == Lower Voltage

V=IR
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V=IR
Resistance Analogy

— D — D
Water Water
Tower Tower

Q)

&% b4
444 ¢
Big Pipe == Lower Resistance Small Pipe == Higher Resistance

VI o V'R
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[

Continuity — Is it a Circuit?

____________

The word “circuit’ is derived from the circle. An
Electrical Circuit must have a continuous LOOP from
Power (V..) to Ground (GND).

Continuity is important to make portions of circuits are
connect. Continuity is the simplest and possibly the
most important setting on your multi-meter.
Sometimes we call this “ringing out” a circuit.

Continuity
setting
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Measuring Electricity — Voltage I

Voltage is a measure of potential electrical
energy. A voltage Is also called a potential
difference — it Is measured between two
points In a circuit — across a device.

-
{

l O 20M0 OFF oo0my
200kQ’/"' TR

20k .7~

20 |

_.I'A!:h -
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Measuring Electricity -- Current m

Current is the measure of the rate of charge flow. For
Electrical Engineers — we consider this to be the
movement of electrons.

In order to measure this — you must break the circuit or
Insert the meter in-line (series).

20MQ o 200mV
200kQ " / 7
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Measuring Electricity -- Resistance .

Resistance is the measure of how much opposition to
current flow is in a circuit.

Components should be removed entirely from the circuit
to measure resistance. Note the settings on the muilti-
meter. Make sure that you are set for the appropriate
range.

Resistance _
settings

( 20MQ  OFF - 200mv
200k0 ,

v
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Prototyping Circuits
Solderless Breadboard

One of the most useful tools in an engineer or
Maker’s toolkit. The three most important
things:

« A breadboard is easier than soldering

* A lot of those little holes are connected, which ones?
« Sometimes breadboards break
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What's a Breadboard?
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Using the Breadboard to built a simple

clrcuit

«s  USe the breadboard to
wire up a single LED

=
=

3V3 5v

s o b= with a 330 Ohm
17 A Resistor (Orange-
Recponrd | i [= Orange-Brown).

mil; = Note: the longer leg on the
m 5 B LED is the positive leg and
- Il the sh_orter leg Is the

negative
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Fritzing View of Breadboard Circuit

What happens
when you break
the circuit?

What if you
wanted to add

more than one
LED?

NI DOTYNY

[ B BN B BN BN ] { I |
rrzrzz 5222023
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s use the Arduino

J

Adding control — let

and start programming

=]
=
-
2
a
x
<
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Concepts: INPUT vs. OUTPUT

Referenced from the perspective of the microcontroller (electrical board).

Inputs is a signal / information  Output is any signal exiting the
going into the board. board.

ems that use physi 0 jouting will have
utput & |

;__..

Whaf are some examples of Outputs? '
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Concepts: INPUT vs. OUTPUT

Referenced from the perspective of the microcontroller (electrical board).

Inputs is a signal / information

going into the board.

Output is any signal exiting the
board.

Examples: Buttons Switches,
Light Sensors, Flex Sensors,
Humidity Sensors, Temperature
Sensors...

Examples: LEDs, DC motor,

servo motor, a piezo buzzer,
relay, an RGB LED
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Concepts: Analog vs. Digital

Microcontrollers are digital devices — ON or OFF.
Also called — discrete.

analog signals are anything that can be a full
range of values. What are some examples?
More on this later...

M RN

Digital Signal Analog Signal
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Open up Arduino %

ARDUINO

Hints:

For PC Users =2 For Mac Users -2

1. Let the installer copy 1. Move the Arduino
and move the files to executable to the dock
the appropriate for ease of access.
locations, or 2. Resist the temptation

2. Create a folder under to run these from your
C:\Program Files (x86) desktop.

called Arduino. Move
the entire Arduino
program folder here.
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Arduino

Integrated Development Environment (IDE)

BareMinimum | Arduino 1.0.3 - O
File Edit Sketch Tools Help

BareMinimurm

oid setup() { L
F4 put your setup code here, Lo run once:

}

void loop () |
A4 put your main code here, to run repeatedly:

}

Two required functions /
methods / routines:

void setup ()

{

// runs once

vold loop ()

{
// repeats




Settings: Tools - Serial Port

sketch_may01a | Arduino 1.0.3 = O
File Edit Sketch |Tools| Help
Qo | Auto Format Ctrl+T Your ComDUter .
M ArhiveSetch communicates to the Arduino
SREILR_Mmay Fix Encoding & Reload . . .
A st microcontroller via a serlal_
Board , port = through a USB-Serial
Serial Port v[v] coms adapter

Programmer b

Burn Bootloader

Check to make sure that the
drivers are properly installed.
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Settings: Tools = Board

. . ATtiny83 (exdernal 20 MHz clock
sketch_jun17a | Arduino 1.0.5 iny83 {edema z clock]
: : ATtinydd (internal 1 MHz clock)

File Edit Sketch  Tools| Help ] ]
ATtinydd (internal 8 MHz clock)
Auto F t Ctrl+T
Hre Forma o ATtiny44 (external 20 MHz clock)
Archive Sketch
. FENIVE SREte ATtiny84 (internal 1 MHz clock)
Skelen_JUnT74 by Encoding & Reload
g ATtiny34 (internal 8 MHz clock)
Senal Monitor Ctrl+5Shift+ P

ATtiny34 (external 20 MHz clock)
ArduBlock III Arduino Uno
Arduing Duem[ﬂ}anwe wy ATmega32d

Board J
Arduine Diecimila or Duemilanove w/ ATmegal68
Serial Port k
Arduino Mano w/ ATmega328
Programrmer k Arduing Mano w/ ATmegal6d
Burn Bootloader Arduinc Mega 2360 or Mega ADK

Arduino Mega (ATmegal220)
Arduino Lecnardo

Arduino Esplora

Next, double-check that the proper board is selected under the
Tools->Board menu.
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Arduino & Arduino Compatible Boards
ARDUINO
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\\@' digitalWrite()

- analogWrite()

‘ —

digitalRead()

o
I_
o
L]
O
Z
O
O
O
O
0
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Let’'s get to coding...

Project #1 — Blink
"Hello World” of Physical Computing

Psuedo-code — how should this work?
Turn ]
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Comments, Comments, Comments

Comments are for you — the programmer and your
friends...or anyone else human that might read your
code.

// this is for single line comments

// it’s good to put a description at the
top and before anything ‘tricky’

/* this is for multi-line comments
Like this..
And this....

*/
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BareMinimum | Arduino 1.0.5
File Edit Sketch Tools Help

BareMinimurm &

// Wame of sketch € “
// Brief Description <€ comments

/7 Date: <€

;f

vold setup ()

{

// put your setup code here, to run once:

vold loop ()
1

// put your main code here, to run repeatedly:
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Three commands to know...

pinMode (pin, INPUT/OUTPUT) ;
ex: pinMode (13, OUTPUT);

digitalWrite (pin, HIGH/LOW) ;
ex: digitalWrite (13, HIGH) ;

delay (time ms) ;

ex: delay(2500); // delay of 2.5 sec.

// NOTE: -> commands are CASE-sensitive
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Project #1: Wiring Diagram

SN - Move the green
' 5 wire from the
power bus to pin
13 (or any other
Digital 1/O pin on
the Arduino board.

=
.......... w3

LI a
.......... ¢ _ .
.......... - 1 Q@ . g

Image created in Fritzing
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A few simple challenges
Let’'s make LED#13 blink!

Challenge 1a — blink with a 200 ms second
Interval.

Challenge 1b — blink to mimic a heartbeat

Challenge 1c — find the fastest blink that the
human eye can still detect...

1 ms delay? 2 ms delay? 3 ms delay???
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Try adding other LEDs

Can you blink two, three, or four LEDs?

(Hint: Each LED will need it's own 330Q
resistor.)

Generate your own morse code flashing

How about = Knight Rider? Disco? Police
Light?
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Programming Concepts: Variables

FrotosnapProMiniExample? &

A4 Comments go here

Variable Scope

A4 Written by:  Joesephine Jones
A Date:r April 12, 2013

int sensorValue;
int ledPin:

Global

vold =etup()
! .
Function-level

A4 put your setup co
int setupWVariabhle;

}

wvold loop ()
A4 put your main code hefe, to run repeatedly:
int loopicopeVariahle

Y
£

O e Tre e rrrrrenerrerererwre 3.0 United States License.
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Programming Concepts: Variable Types

Variable Types:

byte int long
char unsigned int unsigned long
float
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Fading in and Fading Out
(Analog or Digital?)

A few pins on the Arduino allow for us to
modify the output to mimic an analog
signal.

This is done by a technique called:
Pulse Width Modulation (PWM)
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Concepts: Analog vs. Digital

To create an analog signal, the microcontroller
uses a technique called PWM. By varying the
duty cycle, we can mimic an “average” analog

voltage.

A

PWM Signal |,

_________________________

Pulse Width Modulation (PWM)

Medium Voltage Low Voltage High Voltage

=

=

'50%
Duty Cycle

|

| o
I

=h L A '

~ ™M ™ "Actual
Voltage
1
1 | - N -
1 ,,_-,Dl

90%'

Duty Cycle
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Project #2 — Fading
Introducing a new command...

analogWrite (pin, val);

pin — refers to the OUTPUT pin
(limited to pins 3, 5, 6, 9, 10, 11.)
— denoted by a ~ symbol

val — 8 bit value (0 — 255).
O0=>0V | 255=>5V

Sv

Ov

Pulse Width Modulation
0% Duty Cycle - analogWrite(0)

i

25% Duty Cycle - analogWrite(64)

| ]

Ov

50% Duty Cycle - analogWrite(127)

B

O

]

75% Duty Cycle - analogWrite(191)

Sv
Dvl

U U U L

100% Duty Cycle - analogWrite(255)

Sv |

O
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Move one of your LED pins over to Pin 9

In Arduino, open up:
File > Examples - 01.Basics - Fade

Fade | Arduino 1.0.5 - =

File Edit Sketch Tools Help

_

;F -
Fade

Thiz example shows‘how to fade an LED on pin 9
using the analogWrite() function.

Thiz example code iz in the public domain.

=/
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Fade - Code Review

Fade | Arduino 1.0.5
File Edit Sketch Tocols Help

Fade

;F .
Fade

Thiz example shows how to fade an LED on pin 29
using the analogWrite() function.

Thiz example code 13 in the public domain.

=/
int led = 9; /4 the pin that the LED iz attached to
int brightness = 0; /¢4 how bright the LED 1is
int fadelAmount = 5; /4 how many points to fade the LED by
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Fade - Code Review

wold setup ()
/4 declare

{
pin 9 to be an output:

pinMode (led, OUTPUT) ;

/4 the loop routine runs over and over again forever:

vold leoop ()
/4 =set the

{
brightness of pin 5:

analogWrite (led, brightnessz);

/4 change the brightness for next time through the loop:

brightness

// reverse

= brightnesz + fadelmount;

the direction of the fading at the ends of the fade:

1t (brightness == | | brightness == Z55) [
fadeAmount = -fadeAmount ;

}

/4 walt for 30 milliseconds to see the dimming effect

delay (30)
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Project# 2 -- Fading

Challenge 2a — Change the rate of the
fading In and out. There are at least two
different ways to do this — can you figure
them out?

Challenge 2b — Use 2 (or more) LEDs — so
that one fades In as the other one fades
OUt.
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Color Mixing
Tri-color LED

—ft— O
<} .
_I..q_.w

In the SIK, this Is a standard —
Common Cathode LED

This means the negative side of
the LED is all tied to Ground.
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870
I'-U‘J
0,00

Project 3 - RGB LED

Note: The longest
leg of the RGB
LED is the
Common
Cathode. This
goes to GND.

Use pins 5, 6, &9
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How many unique colors can you create?

# of unique colors = 256 - 256 - 256
= 16,777,216 colors!

# |E01B5D

iy Colors

Use Colorpicker.com or
experiment on your
own.

Pick out a few colors that
you want to try re-
creating for a lamp or
lighting display...

Play around with this with
the analogWrite ()
command.
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RGB LED Color Mixing

int redPin = 5;
int greenPin = 6;

int bluePin = 9;

void setup ()

{
pinMode (redPin, OUTPUT) ;
pinMode (greenPin, OUTPUT) ;
pinMode (bluePin, OUTPUT) ;
}
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RGB LED Color Mixing

volid loop ()

{
analogWrite (redPin, 255);
analogWrite (greenPin, 255);
analogWrite (bluePin, 255);
}
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Project: Mood Lamp / Light Sculpture
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Napkin
Schematics

Emphasize the
engineering design
process with
students. We like to
skirt the line
between formal and
Informal with a tool
called NapKkin
Schematics.
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Napkin Schematics
SparkFun Electronics Summer Semester

1. Short Description

Write a brief description of your project here. List inputs and outputs, existing
systems it will integrate with and any other notes that occur to you. Don’t spend too
long on this section.

2. Sketch

Sketch an image of what you imagine your project or system to look like here.

3. Block Diagrams

Draw a diagram where each of the components in your project is represented by a
simple square with lines connecting the components that will be connected. Don’t
worry about getting all the connections perfect; what’s important is that you're
thinking about all the different components and connections. Be sure to include
things like power sources, antennas, buttons or other interface components and
always include at least one LED to indicate the system is on. Although you'll
probably want more LEDs than just the one, they make troubleshooting and
debugging easier.
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4. Logic Flow

Logic Flow Charts are a great way to sketch out how you want a circuit or chunk
of code to act once it is completed. This way you can figure out how the whole project
will act without getting distracted by details like electricity or programming.

There are four major pieces that you will use over and over again when creating
Logic Flow Charts. A circle, a square, a diamond and lines connecting all the circles,
squares and diamonds represent these four Logic Flow pieces.

The circle is used to represent either a starting point, or a stopping point. This is
easy to remember since you start every single Logic Flow Chart with a circle containing
the word Start or Begin. Often you will end a Logic Flow Chart with an End or Finish
circle, but sometimes there is no end to the chart and it simply begins again. This is the
case with any circuits that never turn off, but are always on and collecting data.

The square is used to represent any action that has only one outcome. For
example, when a video game console is turned on it always checks to see what video
game is in it. It does this every time after it starts up and it never checks in a different
way. This kind of action is represented by the square, it never changes and there is
always only one outcome.

The diamond is used to represent a question or actions with more than one
possible outcome. For example, once your video game has loaded there is often a
menu with a bunch of options. This would be written in a Logic Flow Chart as a diamond
with something like the words “Start Up Menu” written inside of it. Lines coming off the
diamond leading to another square, diamond, or circle would represent each action the
user can take from this menu. Maybe our example Logic Flow Chart would have three
options leading away from the “Start Up Menu” diamond, one line to start a new game,
one to continue a saved game and another for game settings. In the Logic Flow Chart
each option is written beside the line leading away from the diamond. It is possible to
have as many options as you like leading away from a diamond in a Logic Flow Chart.

The lines in a Logic Flow Chart connect all the different pieces. These are there
so the reader knows how to follow the Logic Flow Chart. The lines often have arrows on
them and lead to whichever piece (circle, square, diamond) makes the most sense next.
The lines usually have explanation of what has happened when they lead away from
diamonds, so the reader knows which one to follow. Often some of these lines will run to
a point closer to the beginning of the Logic Flow Chart. For example, the “Save Game”
option might lead back to the “Start Up Menu” diamond, or it might lead straight to “Save

and GJEE’. It'S‘Tup@ymu; all it has to do is make sense to you.
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Driving Motors or other High Current
Loads

NPN Transistor (Common Emitter “Amplifier” Circuit)

10k | :

to Digital
Pin 9 =
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Input

Input is any signal entering an electrical system.
« Both digital and analog sensors are forms of input

 Input can also take many other forms: Keyboards, a
mouse, infrared sensors, biometric sensors, or just
plain voltage from a circuit
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Project #4 — Digital Input

In Arduino, open up:
File > Examples - 02.Digital - Button
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Digital Sensors (a.k.a. Switches)
Pull-up Resistor (circuit)

—ip

to Digital Pin 2
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Digital Sensors (a.k.a. Switches)
Add an indicator LED to Pin 13

This is just like our

1St circuit!

p——

— 1 —,to Digital NO Pin 13
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Digital Input

Connect digital input to your Arduino using Pins # 0 — 13
(Although pins # 0 & 1 are also used for programming)

Digital Input needs a pinMode command:
pinMode (pinNumber, INPUT) ;
Make sure to use ALL CAPS for INPUT

To get a digital reading:
int buttonState = digitalRead (pinNumber) ;

Digital Input values are only HIGH (On) or LOW (Off)
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Digital Sensors

Digital sensors are more straight forward than Analog

No matter what the sensor there are only two
settings: On and Off

Signal is always either HIGH (On) or LOW (Off)

Voltage signal for HIGH will be a little less than 5V on
your Uno

Voltage signal for LOW will be OV on most systems
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the button is being pressed or not
being pressed.

‘We declarea
variable as an
integer.

Recall that the pushButton

. variable stores the number 2
We name it

buttonState

The value 1 or O will be saved in
the variable buttonState.

-digitalread-and-
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Programming: Conditional Statements
1f ()

(analogValue > threshold.) {

(ledPin, HIGH);

(ledPin, LOW);

This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 United States License.



http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/

Programming: Conditional Statements

1£()

vold loop ()

{
int buttonState = digitalRead(9);
1f (buttonState == LOW)
{ // do something
}
else

{ // do something else
}
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Boolean Operators

<Boolean> Description

(
(
(
(
(
(

)
)
)
)
)
)

= () IS equal?

= () IS not equal?

> () greater than

>= () greater than or equal
< () less than

<= () less than or equal
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Trimpot (Potentiometer)
Variable Resistor

|- - - == |
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Analog Sensors
3 Pin Potentiometer = var. resistor (circuit)
a.k.a. Voltage Divider Circuit

+5Y +5Y

wiper

fixed o / =
ends \é 1.0V 1.0V

Trimpot é
k
10 kQ
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Ohms Law... (just the basics)
Actually, this is the “voltage divider”
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analogRead()

Arduino uses a 10-bit A/D Converter:

* this means that you get input values from
0 to 1023
« 0V->0
« 5V ->1023

EX:

int sensorValue = analogRead (AO0) ;
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Using Serial Communication

Method used to transfer data between two devices.

Data passes between the computer and Arduino
through the USB cable. Data is transmitted as zeros
(‘0’) and ones (‘1’) sequentially.

10010100110 ...

LU

Arduino dedicates Digital I/O pin # 0 to
receiving and Digital I/O pin #1 to transmit.
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Serial Monitor & analogRead()

sketch_apr02a | Arduino 1.0.3 - H
File Edit Sketch Tools Help

sketch_aprlZa &

A/ analogRead() & Serial.printi) e
A
A

int sensorValue = 0;
int sensorPin = 40;

vold =zetup ()

‘— _ Initializes the Serial
Serial.begin(26e00) ; . ]
Communication

vold loopi()
{

sensorvalue = analogRead(al); 9600 baUd data ra.te
Serial.println(sensorvalue] ;
delay (100); /A waits by ahnuM . .

) prints data to serial bus
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Serial Monitor & analogRead()

sketch_apr02a | Arduino 1.0.3 - H
File Edit Sketch Tools Help

Opens up a
<€— Serial Terminal

Window

sketch_aprlZa &

A/ analogRead() & Serial.printi) e
A
A

int sensorValue = 0;
int sensorPin = 40;

vold =zetup ()

{
Lerial . begin(9s00) ;
pinMode (A0, INPUT) :
'

vold loopi()
{

sensorvalue = analogRead (0] ;
Serial.println(sensorvalue] ;
delay(100); // waits by about 0.1 sec

; v
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Analog Sensors
2 Pin Analog Sensors = var. resistor

Take two sensors -- Use
the Serial Monitor and
& find the range of input
" values you get for each
- 10 kQ Sensor.

+5%

oLt

MaxAnalogRead =

== - MinAnalogRead =
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Analog Sensors

Examples:
Mic soundVolume
Photoresistor lightLevel
Potentiometer dialPosition
Temp Sensor temperature
Flex Sensor bend

Accelerometer tilt/acceleration
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Additional Serial Communication
Sending a Message

void loop ( )

{
Serial.print (“Hands on %) ;
Serial.print (“Learning ”) ;

Serial.println(Y1s Fun!!!”) ;
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BareMinimum | Arduino 1.0.5 = L

File Edit Sketch Tools Help
& COM24 - 0

Barehinire || Send

. Hards on Learning 13 Furr ' !
vold s J ~

R Hands on Learning is Fun!!!
1 1 111

SeriHandS on Learning 15 Fun!!!
} Hands on Learning is Fun!!!
Hands on Learning is Fun!!!
1 1 111

void 1 Hands on Learning is Fun!!!
/ Hands on Learning is Fun!!!
Hands on Learning is Fun!!!

Hands on Learning 1is Fun!!!

Hands o v
< >
y, Autoscroll Moline ending | |9600baud W

Arduino Uno on COMZ2G
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Serial Communication:
Serial Debugging

void loop ()
{

int xVar = 10;

Serial.print ( “Variable xVar 1is % ) ;

& COM24
) =

Serial.println ( xVar

} Variable xVar is 10
Variable xVar is 10

Variable xVar is 10
Variable xVar is 10
Variable xVar is 10
Variable xVar is 10
Variable xVar is 10
Variable xVar is 10
Variable xVar is 10
Variable xVar is 10 v

Autoscroll Mo line ending | |9600baud

This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 United States License.



http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/

Serial Communication:
Serial Troubleshooting

void loop ( )
{
Serial.print (“Digital pin 9: %);
Serial.println (digitalRead(9));
} =

Digital

Digital
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Virtual Electrical Prototyping Project

started in 2007 by the Interaction Design Lab
at the University of Applied Science Potsdam, Germany

Open Source

Prototypes: Document, Share, Teach, Manufacture
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Now that you feel comfortable putting together
circuits with your breadboard let’s talk about how
to go from the breadboard to a PCB

Function
Generator Kit

1 1S workK 1s licensed under a Creative Commons Attribution-shareAlike 3.0 United states License.
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Free Time

The rest of the class is dedicated to free pursuit

Experiment with the various circuits and lessons in
the SIK.

Explore the additional tutorials available on
learn.sparkfun.com

Thank you for attending our Intro to Arduino class
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